ITRL ePortfolio Instructions

In order to have a working, functional ePortfolio on your own Web space, you will need to follow a detailed set of instructions. The process of building your ePortfolio has been divided into three main parts:
1. Setting up your Web space

2. Downloading the template and building your ePortfolio

3. Loading your ePortfolio to your Web space

These instructions are designed for users who have very limited experience with building their own Web page, so feel free to skip ahead if you already have your own Web space and want to move on to the later stages of the walkthrough.

Part 1: Setting up your Web space

The first step in creating your ePortfolio is to set up your very own Web space from which you will host your finished ePortfolio. In order for your ePortfolio to be visible on the Web at any given time, it must be saved on a computer that is constantly connected to the internet (otherwise known as a server). Web space on a server can be acquired online from a variety of different hosts, usually on an annual basis and for a fee. If you already have Web space on a server, please feel free to use it to host your ePortfolio and move on to Part 2. However, if you do not yet have any Web space and you do not want to pay a fee, there is a free and easy way to set up your Web space on the University server.
Every individual who has a Campus Computing ID (CCID) at the University of Alberta is allotted 1GB of Web space on the main GPU server. However, you will not be able to access this Web space unless you go through the necessary steps to activate it. In order to set up, activate, and access your University Web space, please follow these three simple steps:

Step #1: Acquire the necessary programs

Before you begin, you need to make sure that the computer you are using has two programs called PuTTY and WinSCP. Most University computers will already have these programs installed, but they are also available for download at:

http://www.ualberta.ca/AICT/SOFTWARE/filetransfer.html for WinSCP

http://www.ualberta.ca/AICT/SOFTWARE/auth.html for PuTTY 0.57
To download the programs:

1. Click on one of the links above and find the program amongst the list of downloads available. 
2. Click on the download link to the right of the Windows icon  [image: image1.jpg]


. Do NOT click on the link for the program name (PuTTY 0.57 or WinSCP) as it will simply take you to an information page about the program.
3. After clicking on the link, enter your CCID and password
4. Click Run to automatically begin the installation

5. Click on Next to install the default version of the program. 
Step #2: Setting up your GPU account
Now that you have both programs installed: 
1. Click on START at the bottom left of your screen.
2. Select All Programs and find the folder called University of Alberta 2004.
3. Open up PuTTY. IF you are using a school computer, do NOT open up  Authentication; make sure that you are opening the PuTTY Configuration.
4. Enter gpu.srv.ualberta.ca as the Host Name.

5. Make sure SSH is selected.
6. Make sure the Port is set at 22.

7. Click on Open at the bottom of the page. A new PuTTY window will open. 
8. Enter your CCID and press Enter.
9. Enter your password and press Enter.

Now you need to enter a few commands to set up your Web space on the University server. Be sure that you enter the commands EXACTLY as you see them printed here (including spaces between letters and words!) and press the Enter key after each line.
1. First, type in the following command:

/etc/skel/getdotfiles
2. Press Enter.
3. Log out of PuTTY by closing the window and quitting the program.

4. Open PuTTY and login again.
5. Once the PuTTY window opens, enter your CCID and password again.

You will now need to type in some more commands. Be sure to TYPE them in exactly as they are written (cut and paste will NOT work!).
· Please note that every “l” in these lines is a lower case L

· Be sure to press the Enter key after each line



fs setacl ~ system:anyuser l



cd ~



mkdir public_html



fs setacl ~/public_html system:anyuser rl

After this is complete, you can close the Putty session. Congratulations – you have activated your Web space on the University server! 



Step #3: Adding files to your Web space

You can now load files to your web space using the WinSCP program. This entire process is explained in detail in Part 3 of this tutorial. 
Part 2: Downloading the template and building your ePortfolio

Now that you have set up your Web space, we can move on to creating the html content that will appear on your Web site. The ITRL ePortfolio package is designed to provide anyone, regardless of their technical skills and knowledge, with the ability to create and maintain a professional electronic portfolio on the Web. To accomplish this, the ePortfolio package has been set up as a TEMPLATE. This means that most of the content information has already been structured: all that you have to do is plug in your own information. 
The Technical Stuff


Our ePortfolio template consists of a series of linked Web pages, which were  constructed using hyper text markup language (html). As a brief explanation, html is essentially the language of the internet; it exists behind the scenes and tells your Web browser what to display on your screen. So, any time that we refer to html in these instructions, we are talking about the programming language that the ePortfolio was created with.

Another important feature we should mention is that the html templates we have provided were constructed using Cascading Style Sheets. This means that the overall content and html markup does not contain ANY information in regards to the STYLE of the Web page. All style information is included in a separate file known as a Style Sheet. The download package contains a default Style Sheet that you can start creating your ePortfolio with. More are available from the ePortfolio website. This may sound confusing right now, but as you begin working with the template you will soon understand the nature and function of a Style Sheet. 
Downloading the Template

1. Download the template from the Website by clicking on the download link.

2. Click on Save to download the file.

3. Browse for a destination to save the file. We recommend that you save your file to an easily accessible location, such as the Desktop.

The file that you just downloaded is a zip file. This means that the folder that contains your ePortfolio package has been compressed into one file, and in order to access the contents of the folder you must first ‘unzip’ the file. You can unzip the file with WinZip, which your computer should already have, but if it doesn’t you can download it from 

http://www.download.com/3000-2250-10003164.html . To unzip the file:

1. Right-click on the ePortfolio zip file.

2. Highlight WinZip and select Extract to here.

3. A WinZiP window will open. Click on Use Evaluation Version. 

4. The file will then unzip and should create a folder called student on your desktop.

5. Right click on the student folder and select Rename.

6. Change the name of this folder to “ePortfolio”.

The last step is a very important step to make, because later, when you load this folder to your Web space, the name of this folder will become a part of the URL. Once you have re-named the folder, open it up and take a look inside. You should see a few folders, some html pages, and some css pages. The Documents folder is where you will be putting any of the Microsoft Word files or pdf’s that you will be loading to your ePortfolio, while the Images folder will contain the images you would like to use for your ePortfolio. The Packages folder will contain the different style packages that you can download. There is only one package by default but you can download more from our web site. 
Acquiring the Necessary program for html editing


Since you may not have any experience working with html and building Web pages, it might be a good idea to acquire an html editing program. If you already have a Web design program (ie. Dreamweaver, Homesite etc) then by all means use it to edit the content of your ePortfolio. However, since these programs are usually expensive, you may want to download a free html editor rather than purchasing one of these programs. One easy to use program is Nvu Web Authoring System, which you can download for free and use to edit your ePortfolio content. Feel free to use any html editor that you are comfortable with, but if you would like a detailed set of instructions to follow, we recommend that you complete the Nvu download and follow the corresponding instructions below.

You can download Nvu from the following address:

http://www.nvu.com/index.php
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To complete the download:

1. Click on the Downloadslink at the top.

2. This will take you to another download page. Download the corresponding file for whichever operating system you have. (eg. For Windows download the “Windows full installer” and for Mac download the “Macintosh Disc Image”).
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3. Save the file onto your desktop and wait until the download is finished.
4. When the download is finished, open the installer that you’ve just downloaded.

5. This will open the Nvu Setup Wizard. Click Next to continue.
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6. Click on the I accept the agreement button near the bottom of the page after you have read the License Agreement. Click Next to continue.
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7. Click Next.
8. Click Next again. 
9. Click Next again…

10. On this screen, make sure that the check boxes are left unchecked (if you want Nvu to have a desktop icon on your computer, make sure that box is checked). Click Next.

11. Click on the Install button.

12. After the installation is complete, read the information and click Next.

13. Make sure the check box is left unselected and click Finish.
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Using Nvu to Edit the ePortfolio Template


Once you have downloaded First Page, you can go ahead and load the template files into Nvu and begin modifying the content:

1. Go to your Desktop  and open Nvu that you downloaded and installed earlier.

2. Open Nvu and click the Edit Sites button.
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3. A new box will pop up, fill in the Site Name field.
4. The Web Site Information  box can be left BLANK.

5. Under Publishing Server click Select Directory.
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6. Select the file that you named ePortfolio earlier when downloading the template. Make sure that the folder field says ePortfolio
7. Click OK.

8. You should now be back at the Publish Settings window again, just click OK.

9. On the left hand side of Nvu, notice that all the files that belong to your ePortfolio site are now listed in the Nvu Site Manager.
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10. Now you’re ready to start creating content!

From here, you can open all the files from your ePortfolio directly into the main editing window of Nvu. The Nvu Site Manager is great for keeping track of all your files (it can get messy!).

To open up the file that you want to add content to, simply double click on it in the Nvu Site Manager.
This should load the main page of the ePortfolio template in Nvu. The page should be divided into 2 main screens. The section on the left side of the page are where you can browse for and open your html files. The right side of the screen contains the html source code for the current page. 
Take a look at the bottom of the html code section; you should see 4 tabs called Normal, HTML Tags, Source, and Preview. By default, the Normal view is selected. This means that what you see in this window is what you will get in your final product. This is known as a “What you see is what you get” (WYSIWYG) editing window. WYSIWYG editors are great for beginners who are not comfortable dealing with HTML code.

The other tabs bring other views of your web page up. HTML Tags will show you a different type of WYSIWYG window. It will show the layout of the items on your ePortfolio and also what type of code is containing it. It’s good for coders and designers when they want to have more information available to them while previewing a page.

The Source tab is a simple code editor that displays the HTML coding used in your ePortfolio. Nothing too fancy, however, advanced users will probably spend most of their time in this view.

The final tab is a Preview tab. It does exactly what you would expect it to do, allow you to preview what you ePortfolio will look like without using a web browser.

Unless you are comfortable editing html code yourself (in which case you probably do not need this guide), you should stick to one of the WYSIWYG modes in Nvu. The ePortfolio templates are made so that you may simply fill in your own personal information without having to code HTML!

So, lets click on the Normal tab to open up a WYSIWYG(what you see is what you get) mode that will allow you to quickly and easily change the content of your ePortfolio:
The page will now load in a design format where you can simply select text to modify it. Since this is a template, all of the menu items are already set up to go to their own pages (please do NOT try to modify or add menu items!), so all that you have to do is add your name at the top of the page and enter your own information and picture in the content section of the page. To add your own words and content:

1. Highlight the template text, delete it, and type in your own information.

2. If you ever make a mistake, go to the Edit menu and select Undo.

WARNING!

 DO NOT try and edit ANY of the style information on your ePortfolio! Do not try to change the font, size, colour, background, or design of the template or the writing in any way. This template was created using a Style Sheet, and thus any style information that you try to include my cause problems with the programming. Rest assured that you WILL get a chance to change the style information on your ePortfolio, but for now all that you need to do is enter the content information into the template. 
Adding your own pictures and files

Before you can add your own pictures and documents to your Web pages, you need to transfer the files to their corresponding folders within your ePortfolio folder. By copying all of the files into your ePortfolio folder, you will ensure that all of your documents and images will remain intact when you put your ePortfolio on your Web space. 
1. Go to your desktop and open your ePortfolio folder.

2. To save images, open the Images folder. Copy any images that you intend to use into this folder.

3. To save documents, open the Documents folder. Copy any documents (ie. writing samples, pdf versions of your resume, photocopied scholarships, electronic CV’s etc) into this folder.

 Once you have an image saved in your Images folder, you can actually add the image to your Web page. Since we have the index page open in Nvu, let’s try to replace the image of Don Corleone with one of your own images:

1. In Nvu, with the index page open, click on the image of Don Corleone.
2. Without clicking anywhere else, go to the top of the page to the Insert menu.

3. Select Image.
4. Browse for the image you want to place on the page by clicking Choose File. It should be inside of the Images folder in your ePortfolio folder on the Desktop.
5. Select the image file and click OK.
6. If you need to resize the image, you can do so before you even load the file or right in Nvu by clicking on the image and dragging the corners.
7. You can set further options for this image such as Alternate Text. The alternate text shows up when the cursor is held over the image.

Adding direct and relative links


There are two types of links that you can have on your Web page; direct links(hyperlinks) and relative links. Direct links, which are also known as hyperlinks, are connected to other Web pages DIRECTLY, meaning that the link is directed to the full URL of an existing Web page. To make a direct link in Nvu:

1. Highlight the text that you want to make into a link

2. Right-click on the text, and select Create Link. 
3. Type the web address (URL) in the Link Location field. NOTE:  you must include http:// at the beginning of your link location.

4. Enter the full address of the Web page you want to link to in the URL section.
5. Click OK.

Relative links are links that connect to files and other Web pages within the SAME folder as the current html file (ie. all of the other Web pages and documents in your ePortfolio folder). For example, to create a download link to a Word document of your resume, you would do so using a relative link. To make a relative link to a document in First Page:

1. Highlight the text that you want to make into a link.

2. Right-click on the text, and select Create Link. 
3. Click the Choose File button. 
4. Browse for the file that you want the link to open. It should be in your Documents folder in your ePortfolio folder on the Desktop. Under the Files of type: option, you will need to select the All Files option before you can find the file.

5. Once you find the file, select it and click Open then click OK. 
Likewise, you can also create relative links to any of the other html files in your ePortfolio folder. In fact, all of the links on the main menu of your ePortfolio are linked to each other using relative links. If you want to make a link to one of these pages, you can use the same process as above; the only difference is that you would make the link to one of the html files rather than a document. Just remember, if the document or html file has not been saved locally (within the same parent ePortfolio folder), you will not be able to create a working link to it. 
Saving your files

Before you close any of your html files in First Page, make sure that you Save your changes first. 
1. Click on the File menu at the top of the screen.

2. Select Save to save your changes.

3. Alternatively, you can just push the Alt and S buttons on your keyboard at the same time as a shortcut.

Adding Content to the rest of your ePortfolio

After you have added your own content to your index page, you can do the same with the other html pages in your ePortfolio. Save your changes and try loading one of the other html files by double clicking them on the Site Manager. Go through the About Me, Resume, and Sample Work pages to replace the template text with your own personal information. 
The tables in Nvu work a lot like Microsoft Excel tables, if you need more rows to work with, just push Tab when you’ve reached the bottom of the table or try right-clicking for more options.

Again, since the entire template was made using a Style Sheet, it is very important that you do not try to change any of the style and formatting information on the Web pages. Go ahead and use what you have learned about relative links to load any documents or images you might want to include. The Links page is an entire page where you can add any important hyperlinks that you may want to include with your ePortfolio.

Choosing your Style Sheet


Once all of the content has been added to your ePortfolio and you have saved all of your changes, you can finally start implementing some style changes. Since the template uses Style Sheets to implement style information, you need to change the Style Sheet to change the overall look of the ePortfolio. First, you’ve gotta download some more packages. So, go back to the downloads page and get some, when you’re ready, just follow these instructions.
1. Click Tools, and then click CSS Editor.
2. Select the first item in the list on the left (the old style sheet) and then click Remove. You’ll notice that the style of your page is completely gone as soon as you click Remove. Don’t panic, that’s normal.
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3. Next, you should click the Link elt. button, then the Choose File button. From there, open the package folder that you want to use and click the file that ends in .css in the folder of the package that you wish to use and click Open. Usually, it will be named main.css. Don’t worry about what the icon looks like; it’ll be different from computer to computer. As long as the file ends in .css you’re fine.
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4. After this, click the Create Stylesheet button. And then click Close.
5. Now, you  have to repeat steps 1-4 for each page of your ePortfolio. Unfortunately, there is no quick fix to do this automatically for every page.
Take a look at the differences in color and style now that you have loaded a new Style Sheet! Try loading some of the other Style Sheets until you find one that you want to use with your ePortfolio. Once you find the Style Sheet that you want, you should make sure that ALL of your ePortfolio pages are linked to it. To do this, make sure that you make all of the previous Style Sheet changes to each of the html files in your ePortfolio folder. 
Part 3: Loading your ePortfolio to your Web space
Once you have added your content and selected a Style Sheet for your ePortolio, you will need to load your html pages to your Web space. If you followed the procedure in Part 1, you should now have your own Web space on the University server. This section will demonstrate how to load your ePortfolio onto that Web space so that it can be viewed online. To begin:

1. Click on Start at the bottom left of the screen.

2. Select All Programs and find the folder called University of Alberta 2004.
3. Select WinSCP to open the program that you downloaded in Part 1. 
4. Click on New to create a new account. 
5. Under Host Name, enter gpu.srv.ualberta.ca.

6. Make sure that the Port number is left at 22.

7. Login with your Campus Computing ID in the User name and password sections. 
8. Make sure that the SFTP(allow SCP fallback) button is selected.

9. Click on Login at the bottom of the screen.

Once the WinSCP session opens, you should save your login information so that you do not have to enter it again:

1. Click on the Session menu at the top of the screen.

2. Select Save Session. 
3. Enter your name under Save session as: 

This will allow you to quickly and easily access your Web space without having to enter your CCID and password every time.
Now that you have logged in, your own personal WinSCP window containing two frames should be open. The frame on the left represents the files on your hard drive and the frame on the right represents the files in your Web space.

On the right side of the screen:

1. Make sure that you double click and open the folder called public_html.
2. Any files that you transfer to your Web space MUST be placed into this folder or they will not be viewable on the Web.

On the left side of the screen:

1. Browse for your ePortfolio FOLDER. If you have followed these instructions, it should be located on your desktop and should contain all of your html files, documents, and images.

2. Click on the folder and DRAG it to the right side of the WinSCP window into the public_html folder. 
3. A pop-up window will open for you to verify the location of the file transfer; all that you have to do is click on Copy. 
4. This will transfer your entire ePortfolio folder an all of its contents to your Web space.
Now that you have created and posted your files, all that you have to do is check out your new ePortfolio! To access the html files online, simply type in the URL of your directory:

1. Open a browser window (ie. Internet Explorer, Firefox, Safari).

2. Type in the URL of your Web space:

http://www.ualberta.ca/~YOURCCID/ 

For example, my name is Christopher Goetz, and my CCID is cgoetz. This means that the URL to MY Web space is:


http://www.ualberta.ca/~cgoetz/ 

If you enter your own URL into your browser, it should take you to your Web space directory where you can see your ePortfolio folder. When you click on it, the index page of your ePortfolio will automatically load! Take a look at the URL – this is the new link for your very own personal ePortfolio! If you have followed these instructions, the URL for your eportfolio should be http://www.ualberta.ca/~YOURCCID/eportfolio. This is the link that you can add to resumes, share with friends and family, and forward to potential supervisors and employers! You’ve done all of the work to make it happen…now go ahead and share your information with the world. Go ahead…..Get Connected!
